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Introduction 
FlowJo® is an integrated environment for viewing and analyzing flow cytometric data, called a workspace. The 
workspace lists all of the sample data files that you load, displays the gates, statistics, and other analyses that you apply 
to those samples, and provides access to tools, such as graphical layouts and statistics tables, that you can design to 
illustrate and export your analysis. 

The workspace is saved as a document with the file name extension .wsp. When you reopen the .wsp document, you see 
the status of your analysis as it was when it was last saved.

This tutorial is designed to introduce you to the basics of the program. Reading through and performing the steps using 
the provided data and workspace will give you a feel for the workflow through FlowJo. 

The tutorial data is a 9-color panel designed to interrogate phenotypic and functional responses of human T cells 
following stimulation with a mitogen. (See www.ncbi.nlm.nih.gov/pubmed/24464647 for more information about the 
tutorial data.)

Getting Started with FlowJo
Download and Install FlowJo
To begin this tutorial, you first need to install FlowJo. The easiest way to do this is to download the installer from the 
following link: www.flowjo.com/solutions/flowjo/downloads 

• Double-click the link for your platform (Mac or PC) to download the installer, then double-click the installer, 
and follow the prompts.

• Detailed step-by-step installation instructions can be found at: http://docs.flowjo.com/d2/installation/installweb_exe

Launching FlowJo for the First Time
Upon launching the program, you are presented with a licensing dialog box. Agree to the end-user licensing agreement by 
checking the “I Agree” box. If you already have a license for FlowJo, check the appropriate box next to dongle or serial number 
license, and if you choose the latter option, type in the serial number provided by FlowJo or your site license administrator.

NOTE: To utilize the files distributed with this this tutorial, you must have a valid FlowJo license.  
A free 30-day trial license is available using the link below. If you choose to continue without selecting a 
license type, FlowJo can only load specifically enabled demonstration files, such as the 8-color data files.

Free 30-Day Trial
To obtain a free 30-day trial serial number, visit: www.flowjo.com/solutions/flowjo/free-trial 

Purchasing FlowJo
Send inquiries on purchasing a FlowJo license to: office@flowjo.com 

Tutorial Data Download
Basic Tutorial data and 8 Color PBMC Tutorial data downloads: www.flowjo.com/solutions/flowjo/downloads/tutorials

Technical Support
If you have specific questions regarding the functions or features of FlowJo, email Technical Support: techsupport@flowjo.com

Introduction

https://www.ncbi.nlm.nih.gov/pubmed/24464647
https://www.flowjo.com/solutions/flowjo/downloads
http://docs.flowjo.com/d2/installation/installweb_exe
https://www.flowjo.com/solutions/flowjo/free-trial
mailto:office@flowjo.com
https://s3-us-west-2.amazonaws.com/fjinstallers/Tutorials/Data/Basic_Tutorial+Data_20180102T225815Z-001.zip
mailto:techsupport@flowjo.com
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Lesson 1—The FlowJo Workspace Window
Components of the Workspace Window
When you first open FlowJo, you are presented with the 
Workspace window, which is your starting point in FlowJo. This 
window is divided into three horizontal sections. At the top is 
a ribbon containing action buttons, which initiate tasks and 
functions. Below the ribbon is a medium-sized Groups pane. 
Below the Groups pane is a larger Samples pane. (When there 
are no samples in the workspace, the Sample pane reads “Drag 
Samples Here.”)

The Taskbar and Ribbon
At the very top left of the FlowJo Workspace window is the 
Taskbar, which contains a row of static buttons, starting with a 
FlowJo pyramid icon button at the far left, followed by right and 
left arrows, and so on. These buttons perform major functions 
within the workplace, including adding samples, creating 
groups, and opening the Layout Editor and Table Editor 
windows.

Below the Taskbar is the ribbon, which contains six tabs with 
the titles FlowJo, File, Edit, Workspace, Tools, and Configure. Clicking a tab gives you access to a different set of action 
buttons in the ribbon. Each tab is further divided into bands, each with a title at the bottom. For example, the FlowJo tab 
contains the Navigate, Experiment, Biology, and Help bands.

Notice that if you hover the mouse 
pointer over any button, a tooltip 
appears giving more detail about 
that action, along with a hotkey to 
initiate that action. 

ACTIVITY Add Samples to the Workspace
Let’s start by adding samples to a new FlowJo workspace.

1. Find the Basic Tutorial Data folder, which you downloaded with this tutorial.
2. Simply drag and drop the Basic Tutorial Data file folder into the Samples pane.

The sample files load into the FlowJo workspace and appear as part of a new group called Basic Tutorial Data. The 
files also populate the “All Samples” group. Sample file names are displayed in the Name column of the Samples 
pane. 

Workspace Ribbon

Groups

Samples

Taskbar

Mouseover Tooltip

Tabs

Lesson 1—The FlowJo Workspace Window
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Alternatively, you can add samples using the Add Samples action buttons. One is located on the Taskbar, and the 
other is located in the Navigate band of the FlowJo tab.

1. Click Add Samples.
2. Using the file browser, navigate to the Basic Tutorial Data folder. 
3. Select/highlight the Basic Tutorial Data folder, and click Choose.

In the same way, the sample files load into the FlowJo workspace and appear as part of the “All Samples” group. Note 
that a group with the file folder name is only created if you load at the level of a folder that contains sample files.

The Groups Pane
Located within the middle of the FlowJo Workspace window, the Groups pane is populated by default with two groups. 

• The All Samples group, which contains all data files loaded into the workspace. 
• The Compensation group, which automatically includes samples that contain the word “comp” or “unstained” in the 

file name. 

Groups allow you to organize your sample files so that you can perform analysis functions on subsets of samples within 
the workspace. 

Depending on your experimental setup, you can and should use groups to:

• Separate experimental all-stain samples away from single-stain compensation controls, 
• Organize samples by their file keyword attributes (metadata information such as patient ID, stain reagent panel, 

stimulation condition, or time point), 
• Apply a unified gating structure to a set of samples stained with the same reagent panel, 
• Create graphical reports and tables specific to the files contained in the groups.

Add Samples

or drag-and-drop here

Lesson 1—The FlowJo Workspace Window
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ACTIVITY Create a New Group

To get a feel for groups, let’s create a new group.

1. On the Taskbar or in the Navigate band of the FlowJo tab, 
click Create Group.

2. At the top left of the window is an empty text field for 
entering a name for the group. In this field, type a name 
for the group, such as “My Group.”

3. At the bottom right corner of the window,  
click Create Group. 

4. Click the Close button to close the dialog box.

Note that a new row appears in the Groups pane showing 
the group name. However, there are not yet any samples 
in this group, so no sample names are displayed in the 
Samples pane below.

Create Group

Name group

Create group Close

Lesson 1—The FlowJo Workspace Window



 7FlowJo® Basic Tutorial

ACTIVITY Drag and Drop Samples to a Group
To manually place samples within your new group: 

1. Click a group with samples in it to highlight it. This can be the All Samples group or the Basic Tutorial Data group. 
Select the first four samples in the Samples pane (all include LD1 in the name).

2. Drag and drop those samples onto My Group. My Group now includes those samples. 

Note that a single sample can be included in multiple groups (the samples 
you added to your new group are still present in the All Samples and Basic 
Tutorial Data groups). To remove a sample from a group:

1. Select the group you wish to remove samples from.

2. Select the samples you wish to remove.

3. On your keyboard, press Delete.

4. In the “Are you sure you want to remove sample(s)?” prompt, click Yes.

The selected samples are removed from the selected group. Selecting and 
deleting a sample from the All Samples group removes those samples 
completely from the FlowJo workspace. Deleting a sample from any 
group other than All Samples only removes that sample from the selected 
group. If you accidentally remove a sample from the workspace and want 
to bring it back in, simply drag and drop that sample file back into the 
Samples pane, or use the Add Samples action button. The sample loads 
back into the workspace.  

1. Select group that has samples and 
highlight the samples you want to move.

2. Drag and drop them to the new group

Lesson 1—The FlowJo Workspace Window
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The Samples Pane
The bottom section of the Workspace window is the Samples 
pane, which displays a list of the cytometric data files within the 
group you have selected in the Groups pane. 

The Samples pane displays three default columns: 

1. Name—Displays the file name as written in the FCS 
standard ($FIL keyword attribute). 

2. Statistic—Displays calculated statistics for the analysis we 
apply to the sample files. 

3. #Cells—Displays the number of measured events contained 
within the sample file (or gated population once we apply an 
analysis gating structure). 

Sample files are initially listed in alphabetical order by file name.

Sample Badges—Immediately to the left of the sample names is a series of three icons known as sample badges. 

Compensation Matrix Badge (Square)
The square badge closest to the sample name is the 
compensation badge. This square icon presents in one of two 
forms: 

1. An empty square, which indicates that the file does not yet 
have a compensation matrix applied, or 

2. A filled-in latticework square, indicating that a 
compensation matrix has been applied to the file. 

For these samples, the square is filled, because compensation 
was performed on the acquisition cytometer. Therefore, 
these data files already have a compensation matrix applied. 
Double-clicking the square matrix badge displays a window 
in which you can view the associated compensation matrix 
and preview its effect on the data. This window is covered in 
further detail in the FlowJo v10 Advanced Tutorial.

Sample Quality Badge (Circle)
The second (middle) badge indicates sample quality and provides access to sample properties. 

Double-clicking this badge performs a sample quality check evaluating the stability of acquisition over time across all 
fluorescent parameters and brings up a sample Properties window with information on the samples’ keyword attributes, 
acquisition cytometer instrument settings, and compensation. 

The badge color indicates the stability of acquisition, ranging from blue (good quality), to green, purple, or red (poor 
quality). If the color is yellow or red, you might have had some clogging or other disruption in the acquisition of events 
during sample collection on the cytometer. 

File names Statistics Number of 
cells or events

Compensation Badge (square)
Sample Quality Badge (circle)

Population Marker Badge (diamond)

Lesson 1—The FlowJo Workspace Window
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ACTIVITY Check Sample Quality and View Properties of a Single Sample 
1. In the Samples pane, double-click the circle Sample Quality badge.

A properties window is displayed containing information on that sample, and a colored dot appears in the circle 
badge. Blue or green indicated good stability during sample acquisition.

ACTIVITY Check Sample Quality for all Samples in the Workspace
You can also perform a sample 
quality check on all samples in the 
workspace by clicking Check Sample 
Quality, which is located in the 
Cytometry band of the Tools tab.

1. In the ribbon, click the Tools tab.

2. Click Check Sample Quality.

A colored dot appears in the circle 
badges, indicating sample quality/
stability during acquisition.

Population Marker Badge (Diamond)
The leftmost badge references which samples and populations you are currently viewing in a Sample Preview or Graph 
window (explained in the next section). 

If you double-click a sample name in the Samples pane, a Graph window opens displaying a dot plot. The diamond 
marker badge next to the sample name turns blue, indicating this sample is being viewed in the active Graph window. 
A solid blue badge indicates that sample’s Graph window is selected, and a hollow blue badge indicates that sample is 
displayed in a Graph window, but that Graph window is not currently selected.

END of Lesson 1—The FlowJo Workspace Window

Lesson 1—The FlowJo Workspace Window
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Lesson 2—The Graph Window and Gating
The Graph Window
The Graph window displays a graph plot representation of the data in a cytometry file or a population within it. This 
representation allows you to visualize the distribution of collected events (in this case human lymphocytes) along one or 
two measured cytometric parameters. 

(Note that in flow cytometry, a ‘parameter’ generally refers to a specific fluorescent pulse measurement collected in a 
single channel on the cytometer instrument. These measurements can represent the expression levels of specific cellular 
proteins or represent other features of a cell, such as size, viability, DNA or membrane content, or functional processes 
like metabolism and signaling.) 

The Graph window provides tools to draw geometric gates on the events distributions. Creating a gate isolates the 
events included within the gate, producing a ‘child’ population from the parent set of events. Creating a series of gates 
on different measured parameters allows you to build a gating hierarchy or gating tree, which subsets the measured 
events down to specific populations based on their expression of the measured parameters. 

ACTIVITY Open a Graph Window 
1. Double-click the first sample in your workspace: LD1_

NS_NS. (Click the sample name, not any of the symbols 
to the left.) This opens a Graph window plotting events 
along forward scatter (FSC) versus side scatter (SSC) 
parameters.  
Notice that next to the sample name in the Workspace 
window, the blue diamond population marker badge fills 
with a solid blue color. 
Each dot on the graph plot represents one or 
more individual cells on which a set of cytometric 
measurements were taken. The density of events at 
a given position in the plot is color-coded, with red 
representing the highest number of events at that point 
in the graph, while yellow, green, and blue represent 
progressively lower event densities.

Components of the Graph Window
Gating tools are located at the top left corner of the window. 

Undo/Redo and Navigation buttons can be found at the top right.

X and Y axis Labels specify which measured parameters are represented in the graph plot. Clicking the label for an axis 
allows you to change which parameter is displayed on that axis.

A Transformation (T) button is found next to each axis label, which allows you to change the X or Y axis scaling.

Additional plot and gate display options are located in expandable bars at the bottom of the window. 

Gating Tools Undo/Redo + Navigation

Measured Parameter Distribution

Transform Data Display

Lesson 2—The Graph Window and Gating
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ACTIVITY Draw an Ellipse Gate
Let’s isolate the major lymphocyte population here with an ellipse gate. The lymphocytes are the majority population 
in this plot, where the red, yellow, and green data points represent higher-density regions of events. To create and 
ellipse gate:

1. Click the Ellipse tool.

2. Position the mouse cursor at 
one edge of the population 
you want to isolate. Click 
and hold down the mouse 
button, drag to enclose the 
population, and release.

3. Name your gate or use the 
suggested “Lymphocytes,” 
and press return or click OK. 
Your gate is now created and 
appears on the graph plot.  
Notice that the gate name 
and a statistic (called 
Frequency of Parent) appear 
along with the gate. This 
statistic represents the 
percentage of events from the 
parent population (the events 
displayed in the graph plot) 
that are contained within 
the child gate. Frequency of 
Parent is the default gating 
statistic. 

4. Click and hold down the 
mouse button on the Gate 
label, and drag the label away 
from the gate.

1. Select Ellipse tool.
2. Hold down mouse button. 

Drag across population and 
release.

4. Click and hold mouse 
button on the Gate name. 
Drag the Gate name to 
reposition.

3. Name the gate and click OK.

Lesson 2—The Graph Window and Gating
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5. Click and hold down the mouse button on the ellipse gate (not the label). Try dragging the gate to a different 
position in the plot, and release the mouse button. Notice how the frequency of parent statistic updates when the 
gate is moved. 

6. Click and hold down the mouse button on one of the square gate handles along the edge of the gate, and drag the 
handle to modify the size or shape of the ellipse.

7. Try to resize and orient the ellipse so that it encompasses the major population. 

8. When you are happy with the size and shape of your ellipse gate, double-click within the gated area. This opens a 
new Graph window isolating the events in that gate based on FSC and SSC parameters.

5. Drag the gate to a different 
position.

6. Drag square handle to resize.

7. Resize and position so that 
the gate encompasses the 
lymphocyte population.

8. Double-click on the population to 
display a Graph Window with the 
gated events.

Lesson 2—The Graph Window and Gating
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ACTIVITY Draw a Polygon Gate to Isolate Live Cells
Amine reactive dyes (ARD) are a live/dead discriminating stain reagent. Dead cells, having permeable plasma 
membranes, take up the dye and fluoresce brightly in the ARD channel, while live cells with intact plasma membranes 
exclude the dye and have a low ARD signal. Therefore, to isolate the live cells, we will gate on the ARD negative 
population and exclude ARD positive events. 

1. First, to display the ARD parameter in the graph window, click the Y axis Label. A list of available measured 
parameters will be displayed. Select the Comp-AARD-A :: Dead parameter. The Y axis will change to display the 
measured fluorescence of an aqua amine reactive dye (AARD).

2. Next, select the Polygon Gate tool.

3. Click within the plot to set the points to make up the polygon gate. Make as many sides as desired. Note that holding 
down the Shift key modifies polygon gate side creation by limiting the angle to 45-degree increments. 

4. Double-click to close the polygon and create the gate. 

5. Give your gate a name such as “Live” and press OK

1. Click on the Y-axis and select the 
Comp-AARD-A :: Dead parameter.

2. Select Polygon gate tool.

Lesson 2—The Graph Window and Gating

3. Click, move, click to create each side.
4. Double-click to close and create the 

new gate.

5. Name the gate and click OK.
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ACTIVITY Change Plot to a Histogram; Draw a Range Gate to Isolate CD3+ T Cells 
1. Double-click within the new “Live” gate. A new Graph window appears displaying only the Live events.

2. Click the X axis parameter label. From the list of available parameters, select Comp-Ax700-A :: CD3. Click the Y 
axis parameter label, and select Histogram. This changes the plot to a one-dimensional histogram. Notice that the 
available gating tools in the top left corner change, and display either a range or bifurcation gate.

3. Select the Range Gate tool.

4. Make a gate on the right peak of the bimodal CD3 distribution: On one side of the peak, click and hold down the 
mouse button, move the cursor to the other side of the peak, and release the mouse button.

5. Give your new range gate a name, like CD3+, and click OK. You have now isolated the events that express CD3, an 
essential component of the T cell receptor.

Lesson 2—The Graph Window and Gating

1. Double click on Live Gate

2. Select CD3 vs Histogram
3. Select Range gate tool
4. Click, hold and drag mouse to 

create range gate
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ACTIVITY Draw a Quadrant Gate to Isolate CD4+ Versus CD8+ T Cells
Now let’s further subset the CD3+ cells into CD4+ T helper versus CD8+ cytotoxic T lymphocytes.

1. Double-click the CD3+ gate. A new Graph window opens containing only the CD3+ events. Change the X axis 
parameter to display Comp-PE-TxRed-A :: CD4. Change the Y axis parameter to display Comp-PacBlue-A :: CD8.

2. Select the Spider Quad Gate tool.

3. Position the mouse cursor at the location you want the common vertex of the quad gates. Click the mouse button 
once to make the quadrant gates appear. You have now created quadrant gates isolating CD4 vs. CD8 expressing T 
cell populations.

4. Click any of the square handles, and drag the handle to a new position. You can move the quad gate vertex and 
modify the angle of individual arms of the gate in this way.

 

Lesson 2—The Graph Window and Gating

1. Double click on the CD3+ 
gate and Select CD4 vs CD8

2. Select Spider Gate tool
3. Click within the graph plot at the 

desired center vertex location of 
the quad gate.

4. Grab square handles and move to 
reposition quadrant arms.
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ACTIVITY Draw a Rectangle Gate to Isolate Perforin+ CD8+ Cytotoxic T Cells 

Now let’s focus on the CD8+ T cells and draw a gate to isolate the Perforin+ subset.

1. Double-click the Q1: CD4-,CD8+ population to open a new Graph window containing only the CD8+ T cells. Change 
the X axis parameter to display Comp-PE :: Perforin.

2. Select the Rectangle Gate tool. Position the mouse cursor where you would like one corner of the rectangle gate to 
be, click and hold down the mouse button and drag the cursor diagonally, then release the mouse button to create 
the gate. 

3. Give your new gate a name, such as Perf+, and click OK. You have now isolated the Perforin+ cells within the CD8+ T 
cell compartment.

Modifying the Data Scaling and Visual Display using the T (Transformation) Button
Sometimes, depending on the type of flow cytometry file and how the acquisition software specifies the scaling of 
measured parameters, the visual display of data is not initially ideal for viewing the entire data distribution. Parameter 
scaling can be easily changed using the Transformation (T) button located next to the axis parameter label. Let’s 
go ahead and modify the data display of the Perforin parameter and explore the scaling options available within a 
biexponential (Biex) transform function. Note that a biexponential transform function displays the data in a linear scale 
around zero and a log scale further out. 

1. Select Perforin

2. Select Rectangle Gate tool
3. Click, hold and drag mouse diagonally 

then release to create rectangle gate.

Lesson 2—The Graph Window and Gating
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ACTIVITY Use the T (Transformation) Button to Modify the Graph Plot Scaling and Display
1. Click the T button next to the X axis Perforin parameter label, and select 

Customize Axis. This will open a Transformation window with the 
Perforin parameter displayed as a histogram.

2. Under the Scale options, notice that the Scale is already set to Biex by 
default. With Biex selected, you can:

• Modify the maximum positive range displayed by using the -/+ 
buttons located to the right of the plot x axis label.

• Add or remove extra negative range using the Extra Neg Decades 
slider bar.

• Change the compression of the data around zero using the Width 
Basis slider bar. 

3. In the Extra Neg Decades box, try moving the slider bar to the left. This 
shifts all the plot data to the left, giving less extra space on the low (negative) 
end of the scale. Try setting the Extra Neg Decades to a value of 0.

4. In the Width Basis box, try sliding the With Basis Notice that moving the slider to the right compresses the data 
around zero, and moving the slider to the left spreads the data out around zero. Set the Width basis back to 1 (-10).

5. On the right side of the window, highlight all parameters with a Comp- prefix.

6. Click Apply. 

The Transformation window will close and all selected parameters will receive the scaling changes made. In this case, 
we’re just getting rid of some of the extra unused white space on the low (negative) end of the scale by reducing the extra 
Neg Decades from 0.8 to 0, while keeping the same Maximum Range and Width Basis compression around zero. This 
gives us more visual space to view the distribution of the Perforin expression profile. Each measured parameter can be 
uniquely scaled to robustly visualize the distribution of events. Importantly, transformation does not change the raw 
data, only the way it is scaled and displayed visually in the graph plot.

Lesson 2—The Graph Window and Gating

2. Select Biex scale.

Maximum Range

Width Basis (compression around zero)Extra Neg

3. Set Extra Neg Decades to 0
4. Slide Width Basis to see effect 

then set back to 1 (-10).
5. Highlight all Comp- parameters
6. Click Apply

1. Click on the T button and select 
Customize Axis.

Result of Biex Scale modification.

Lesson 2—The Graph Window and Gating
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Applying a Gating Hierarchy to a Group

Now that we’ve created a series of gates on one sample, we want to apply those gates to all samples stained with the same 
panel. To do this, we will apply the gates to a group of samples within the Groups pane of the FlowJo Workspace.

ACTIVITY Group Apply the Gating Hierarchy
Click on the Workspace window. Notice that the gate names you created are displayed as indented populations below 
the sample file you have been working with in the Graph Window. The gate names are a black color and only appear 
below that single sample. 

To apply these gates to a group:

1. Select/highlight the Basic Tutorial Data Group (which should contain all eight samples). 

2. Select/highlight all the gate names listed below the single sample with gates.

3. Right-click (or Control-click) any of the highlighted rows, and select Copy analysis to group. The gating tree is applied to 
all samples within the group. Notice that the gates appear both under the samples (in the Samples pane) and under the 
group (in the Groups pane) Your gates now apply to the group and change from black to the color of that group.

Lesson 2—The Graph Window and Gating

1. Select/highlight group
2. Select/highlight gates on a single sample
3. Right-click on selected gates and select 

Copy analysis to group

Result of Copy analysis to group function
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Modifying a Group-Owned Gate

Once gates are applied to a group, they turn the color of that group to denote that they are group-owned and identical to 
each other. However, you can still modify a gate on a single sample.

ACTIVITY Modify a Group-Owned Gate on a Single Sample 

1. Double-click the Q1 CD4- , CD8+ population node within the group-owned gating tree under a single sample in the 
workspace. This displays a Graph window containing those gated events displaying Perforin vs CD8 parameters.

2. Click the Perf+ Rectangle Gate tool to select it. Click on the gate and holding down the mouse button, move the 
gate to a slightly different position. Notice that when the gate is moved, the color of the population node within 
the workspace gating tree of that sample turns from the group’s color back to black. The black color indicates that 
the gate on that sample is unique to that sample and is not the same as the other group-owned gates on the other 
samples in that group.

3. To apply the change you have made to the group:

• Select/highlight the gating group.

• Select/highlight only the black gate name. (You may need to click on a different gate that is not highlighted first 
to deselect all the group applied gates, then select the black gate name.)

• Right-click the selected population, and click Copy analysis to group.

• You receive a warning that the parent population already has a gate with the same name. Click Yes at the “Do 
you want to replace it?” prompt.

The modified Perf+ gate will apply to the group and turn the group color. Now all the samples in that group have 
received the modified gate and the gates are again identical. 

Lesson 2—The Graph Window and Gating

1. Grab and move gate position

Black gate node color = modified gate 
not group owned Apply gate change to group 

• Highlight the gating group
• Highlight the black gate group
• Right-click and select Copy analysis to group
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This sequence of steps works to update the group owned gating structure with any changes to gating or statistics that 
you make on individual samples. However, you may want your group owned gates to remain ‘synchronized,’ so that any 
modifications made to a group owned gate automatically applied to the group. This eliminates the need to copy a gate 
change to the group gating hierarchy. To synchronize group owned gates: 

ACTIVITY Synchronize Group-Owned Gates
1. In the Groups pane, double-click the gating group name (example: Basic Tutorial Data). This opens a Modify 

Group window.

2. Check the Synchronized box.

3. Click Apply Changes.

4. Close the modify group window. Your group gates are now synchronized so that modifying a group-owned gate 
on a single sample automatically applies that change to all the samples in the group.

Because we are done creating gates for now, let’s go ahead and close the open Graph windows to get them out of the way.

ACTIVITY Close Graph Windows
1. Select a single Graph window by clicking the window once.

2. To close this single Graph window, click the Close button at the top of the window.

3. To close all open Graph windows at once, use the hot key command: Shift+Command+W for Mac, or Shift+Ctrl+W 
on a PC. 

End of Lesson 2—The Graph Window and Gating

Lesson 2—The Graph Window and Gating

1. Double-click on the gating group
2. Check Synchronized box
3. Click Apply Changes
4. Click Close
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Lesson 3—Adding Statistics
Statistics Band
The basic gating statistic in FlowJo is Frequency of Parent (Freq of Parent). However, you can also enumerate other 
statistics for gated populations using the Statistics band of the Workspace tab. 

Options include event count, measurements of central tendency such as median or geometric mean fluorescence 
intensity (MFI or GMF), coefficient of variation (CV), or frequency of any upstream population in the gating hierarchy, 
among others. 

Note that if the Statistics band only shows a single icon, it is collapsed. Widen the Workspace window until the 
individual actions in the Statistics band are visible. If the buttons are grayed out, select a population.

Add Statistic—Brings up an Add Statistic 
dialog box with all statistics options.

Median—Displays a drop-down list to 
add a Median of any parameter to the 
populations selected in the workspace.

CV—Displays a drop-down list to add 
a CV in any measured parameter to the 
populations selected in the workspace.

Freq. of—Displays a drop-down list to 
add the Frequency of any upstream gated 
population.

ACTIVITY Add a Median Statistic to a Gated Population, then Group Apply
1. In a workspace sample gating tree, select the Q1: CD4- , CD8+ population.

2. In the Statistics band of the Workspace tab, click the Median tool. A drop-down list of measured parameters 
appears.

3. Select the Median > Comp-Ax488-A :: p-ERK1_2 Parameter.  
A black statistic node labeled Median : Comp-Ax488-A (p-ERK1_2) appears below the selected population. 

 

Lesson 3—Adding Statistics
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ACTIVITY Group Apply the Statistic Node
Now we want to apply that statistic node to the group gating tree. This works the in same way as applying a gate to a 
group.

1. Select the gating group.

2. On the single sample, select the black Median statistic node.

3. Right-click the statistic node, and select Copy analysis to group.

The Median statistic becomes part of the group-owned gating tree, and turns the color of your gating group. Now all 
samples in the group have that statistic applied.

1. Select population
2. Click the Median button
3. Select parameter from the 

dropdown menu

Median statistic Node created

1. Select gating group
2. Select black statistic node
3. Right-click on statistic node and 

select Copy analysis to group

Group applied Statistic node is present in 
group gating tree and gains group color

Lesson 3—Adding Statistics
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Add Statistic Window
The most versatile tool in the Statistics band is the Add Statistic option, which opens up a window allowing addition 
of any statistic to any population in the gating tree of a selected sample. This facilitates applying multiple statistics to 
different populations within a gating hierarchy in quick succession.

ACTIVITY Add Multiple Statistics using the Add Statistic Window
1. Within the gating tree of a single sample, select any population node. (Usually this is the first population you want to 

add a statistic to. In this example I will highlight the Q1 : CD4- , CD8+ gate.)

2. Click Add Statistic.

3. Select the Statistic you wish to add (Geometric Mean in the example below).

4. Select the Population you wish to apply the statistic to. (This field automatically populates with the population you 
highlighted in the sample gating tree. In this example I will first leave the default population, apply a statistic, then 
change to a different population and apply the same statistic (steps 7–8 below).

5. Select the Parameter you wish to enumerate (Comp-PE-A :: Perforin in the example below).

6. Click Add. This creates the new statistic in the sample gating tree, but the Add Statistic window remains open, 
allowing you to add additional statistics in sequence without reopening the window. Let’s try adding the same 
statistic to a different population in the gating hierarchy. 

7. Keeping the same Add Statistic window open, change the population by clicking the Population field, and select a 
different population from the drop-down list (example: Q3: CD4+ , CD8-).

8. Click Add. The statistic node is added to the selected population in the sample gating tree. 

9. Close the Add Statistic dialog box by clicking the Close button at the top of the window.

1. Highlight a population node 
within a sample gating tree.

2. Click Add Statistic
3. Select the type of statistic

4. Select Population from the drop 
down menu

5. Select the Parameter
6. Click Add

Lesson 3—Adding Statistics
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As we’ve done previously, you can apply the statistics nodes to the gating tree for the entire group:

1. Select the gating group. 

2. Select both black statistic nodes on the single sample where they currently reside.

3. Right-click the sample, and select Copy analysis to group.

The statistic nodes are applied to the group gating tree and samples therein, at the correct position within the gating 
hierarchy. 

End of Lesson 3—Adding Statistics

Lesson 3—Adding Statistics

7. Select different population from 
the Population drop down

8. Click Add

1. Highlight gating group
2. Highlight black statistic nodes 

and right-click
3. Select Copy analysis to group

Statistic nodes added to gated populations 
using the Add Statistic window

Statistics are group applied 
and gain the group color
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Lesson 4—The Layout Editor 
The Layout Editor is a platform with tools for displaying multiple graph plots and statistics in a graphical report, which 
resides in its own window separate from the Workspace window. Layout Editor reports can be exported as images or 
‘batched’ across samples to generate customized external reports.

Components of the Layout Editor
Ribbon—The Layout Editor has its own ribbon with a series of five tabs to access the formatting, layout, and other 
functions.

Add New, Duplicate, and Delete Layouts—The default tab, called Layout Editor, presents a list of layouts. You can create, 
duplicate, or delete existing layouts using the three buttons to the left of the Layouts list. To rename a layout, double-
click the layout name.

Drawing Tools, Grids, and Stats tools—A static toolbar with basic drawing tools, grids, and a plate statistic tool.

Zoom—Zoom functions are found at the bottom left corner.

ACTIVITY Drag a Gated Population to the Layout Editor
Let’s bring a population into the current layout and view the graph. 

1. On the workspace toolbar, click the L button to open the Layout Editor. Position the Workspace window and Layout 
Editor side-by-side.

2. From the gating tree of a sample in the Workspace window, drag a population (example: Q1: CD4- , CD8+) into the 
Layout Editor.

Drawing Tools, Grids, and Stats tools

Add New, Duplicate, and Delete Layouts

Zoom

Tabs

Lesson 4—The Layout Editor



 26FlowJo® Basic Tutorial

A graph plot displaying the gated events appears in the Layout Editor. Basic information, including the sample name, 
gate name, and event count, are displayed in a text box below.

ACTIVITY Show the Gating Hierarchy Upstream of a Graph Plot Population

1. In the Layout Editor, right-click the graph plot.

2. In the drop-down list, select Ancestry.

Thumbnail images are displayed to the right of the original plot showing the gating hierarchy used to define the 
population of events in that original larger plot. 

1. Open the Layout Editor and 
position windows side by side.

2. Drag and drop the population to 
the Layout Editor

1. Right-click on the graph
2. Select Ancestry

Thumbnail images = Gating 
hierarchy used to define 

gated population

Lesson 4—The Layout Editor
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Note: There are a number of useful actions you 
can access by right-clicking the graph plot, but you 
might need to resize the Layout Editor window, 
or use the Zoom options, in order to see the entire 
series of thumbnail plots or other features you 
choose to display. You can resize and reorient the 
pages by dragging the intersection points of the 
dashed page break lines. The page break lines can 
also be hidden completely by toggling off by clicking 
the Show/Hide Pagebreaks action button (located 
under the Edit tab).

ACTIVITY Change the Graph Plot Axis 

1. Right-click the graph axis label annotating the currently displayed parameter (example: Comp-PE-A :: Perforin).

2. Select a different parameter (example: Comp-Ax488-A :: p-ERK1_2) from the drop-down list.

The selected parameter is displayed in the Layout Editor plot. This capability allows you to quickly modify displayed 
parameter information. 

Show or Hide Pagebreak completely

Zoom In or Out

Drag Page break corner to move

Expand Layout Editor Window by 
dragging the corner of the window

1. Right-click on the axis label
2. Select Parameter

New selected parameter is displayed

Lesson 4—The Layout Editor
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ACTIVITY Rename a Layout
Try renaming the layout to something more specific. 

1. Double-click the layout’s name, and give it a more 
descriptive name based on the population you brought 
into the layout and are now observing the phenotypic and 
functional properties of (example: CD8+). 

Note that in this example, we have defined single-cell events 
that are lymphocytes based on scatter profile and express both 
CD3 and CD8 on their surface. Therefore, by definition they are 
CD8+ cytotoxic T cells.

ACTIVITY Open the Graph Definition Properties
Additional options for graph plot formatting and display can be accessed through the Graph Definition (aka Properties) 
window. To open this window:

1. Right-click the graph plot, and select Properties.

1. Double-click to rename layout

1. Right-click on graph plot
2. Select Properties

Tabs

Parameters

Plot Type

Plot Options

Apply Selected Properties

Lesson 4—The Layout Editor
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A Graph Definition window appears. This window has four tabs with formatting and legend options for the Layout 
Editor graph plot. With the default Specify tab selected, you can change the displayed parameters, type of plot, and 
display options. 

The other tabs (Annotate, Fonts, and Legend) each contain additional options to modify the graph plot formatting and 
information displayed. 

Let’s modify a couple of the formatting options to get a feel for the process.

ACTIVITY Show a Background Grid in the Layout Editor Graph Plot
1. Position the Properties window to the right of the graph plot displayed in the Layout Editor.

2. Within the Graph Definition window, check the Show Grid box.

3. Click Apply. 

ACTIVITY Increase Font Size for Plot Axis Labels 
1. In the Graph Definition window, select the Fonts tab.

2. Under Axis Labels, select Size, and pick a larger font size (example: 18 pt).

3. Click the Color box, and choose your favorite color (example: purple).

4. Click Apply. The font size and color selected within the Fonts tab of the Graph Definition window are applied to the 
Layout Editor plot.

5. Close the Graph Definition window by clicking the Close button at the top of the window.

1. Move the Graph Definition window 
so that the plot is visible

2. Check Show Grid
3. Click Apply

Background Grid is 
displayed on plot

Lesson 4—The Layout Editor
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Now that we know where the graph properties and formatting options are, let’s move on to reviewing data using the 
iteration functions.

Iteration
Iteration functions are located in the Layout Editor tab, next to your list of Layouts. By default, you see two drop-down 
menus: 1) Group and 2) Iterate by. 

The Group menu allows for selection of a workspace group containing the samples you wish to focus on for review and 
reporting, while the Iterate by menu controls the units over which you want to look at the samples within the selected 
group. 

To get an idea of how this works, let’s start by changing the Iterate by option from Off to Sample and review the samples 
in a group.

ACTIVITY Iterate by Sample and Review Samples in the Layout Editor
1. Click Iterate by, and select Sample from the menu. A new Value selection menu appears below the Iterate by menu.

2. Click Value, and select a different sample (example: LD1_NS+PI_C01_exp.fcs). Notice that the distribution of events 
along the Comp-Ax488-A :: p-ERK1_2 axis changes. We are now viewing a different sample that has been stimulated 
with a mitogen, as opposed to the LD1_NS+NS, which is a no-stimulation control. 

3. Next to the Value menu, click the Down arrow , then click the Up arrow. Notice that these buttons allow you to scroll 
up and down through files in the selected group.

1. Select Fonts tab
2. Pick a font size
3. Pick a font color
4. Click Apply

Axis label font size modified

Lesson 4—The Layout Editor
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Batch Reporting
Batch reporting, or ‘batching,’ in the Layout Editor enables the application of a layout (which can contain many plots and 
statistics with user-defined formatting) to the selected group of samples across the selected Iterate by criteria. 

For example, with the Iterate by setting set to Sample, the batch process applies the layout to each sample in the 
specified group, displaying data from each sample one at a time. 

Let’s give batching a try.

1. Select Iterate by: Sample

2. Select Value: LD1_NS+PI

3. Click to move up/down through 
samples in the group

The p-ERK distribution changes 
due to stimulation with a mitogen

Annotation Box:
• Sample Name
• Gate/Population Name
• Event Count

Lesson 4—The Layout Editor
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ACTIVITY Generate a Batch Report
1. Widen out the Layout Editor window until the Batch band expands.

2. Click Create Batch Report. 

A layout is created with the suffix -Batch in the name. This layout contains plots and information for each sample in the 
specified group, and individual sample data is tiled across the page with the orientation specified in the Batch options 
(Rows or Columns and Up or Down). In this case we left the default settings so the layout and batched samples with 
three columns across. Instead, let’s try the batch again, but change the orientation options to Two Rows Across.

ACTIVITY Modify Orientation of a Sample Iteration Batch Report
1. Select the original layout (with just one sample displayed).

2. Under Batch options, select the Rows button and set the number of rows to 2.

3. Select the Across button.

4. Click Create Batch Report.

1. Widen out the Layout Editor window 
until the Batch band expands.

2. Click Create Batch Report

Batch orientation settings

Samples are tiled in the new layout 
based on Batch orientation settings

New Layout with -Batch suffix

1. Select original layout
2. Select Rows and set to 2
3. Select Across
4. Click Create Batch Report

Lesson 4—The Layout Editor
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The sample tiles of the resulting two-rows-across batch report are oriented 4x2 because there are eight samples in the 
Basic Tutorial Data group. Note that the batching process runs in order of the samples as they are listed in the Samples 
pane. 

Now let’s try batching to a Web Page report outside FlowJo.

ACTIVITY Batch Report as Web Page
1. Select the original layout (with just one sample displayed).

2. In the Batch band, select the Web Page option.

3. Click Destination, and select a location to save the web page link (.html file).

4. Click Create Batch Report. 

Sample 1

Sample 1

*Note that the batching 
process runs in order of 

the Workspace list

Sample 8

Sample 8

1. Select original layout
2. Choose Web Page from drop down menu
3. Choose Destination
4. Click Create Batch Report

Lesson 4—The Layout Editor
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A web page .html file is saved to the destination selected, PNG images for each sample are saved to the same location 
within a folder called FlowJo Web Files, and the images open in your default web browser. Try scrolling down through 
the layout plots to view each individual sample. If you close the web browser tab and wish to view the images again in 
your browser, simply double-click .html file. Note that there are also options for batching directly to a Printer, PDF or 
PowerPoint file.

Overlays
Now, we will create an overlay comparing multiple samples in the same graph plot. 

ACTIVITY Create a Dot Plot Overlay and Convert it to a Histogram
1. In the Layouts list, select the original layout (example: CD8+).

2. To the left of the Layouts list, click the Duplicate Layout button.

3. Within the gating hierarchy of the second sample in the Workspace window’s samples list (example: LD1_NS+PI_
C01), select the Q1: CD4- , CD8+ population node.

4. Drag and drop this population onto the same plot in the Layout Editor. A dot plot overlay is created.

5. If you are prompted with an iteration mismatch warning, select the Turn Off Iteration option. The layout plot 
converts to a dot plot overlay, and the ancestry thumbnails disappear and are replaced by a color-coded legend.

6. Right-click the dot plot overlay, and select Properties, bringing up the Graph Definition window.

7. In the Graph Definition window, click the Specify tab.

8. Using the Type drop-down list, change the plot from Dot Plot to Histogram.

9. Further down in the window, use the Y axis drop-down menu to change the Y Axis style from Auto to Modal.

10. Click OK. The plot converts to an overlaid histogram with the peak heights normalized to mode (the peaks look the 
same height even though there are may be different numbers of events in the two populations).

11. Finally, right-click the plot, scroll to the very bottom of the drop-down list, and select Histograms » Offset. The plot 
displays each histogram stacked independently on the Y axis.

1. Select original layout
2. Click Duplicate layout

3. Highlight same gate in hierarchy on 
second sample

4. Drag and Drop onto plot in Layout

5. Click Turn Off Iteration

Lesson 4—The Layout Editor
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Result of drag and drop of dot plot overlay. Same 
gated population in two different samples

Offset Histogram view

6. Right-click on the plot and 
select Properties

11. Right-click on the plot and 
select Histograms » Offset

7. Select Specify tab

8. Set graph type to Histogram

9. Set Y Axis to Modal

10. Click OK
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ACTIVITY Modify the Histogram Formatting
If you don’t like the default line thickness, style, or shading options, you can easily change them, either globally for all 
populations in the overlay, or individually for each specimen in the overlay. Let’s try a global change to make the line 
weight heavier and remove the tint color.

1. Right-click the histogram overlay plot. Near the bottom of the list are options for Coloring, Line Style, and Line Weight.

2. Choose Line Weight » Heavy. This changes the line thickness for all populations represented in the plot, making the 
lines Heavy and easier to see.

3. Right-click the histogram overlay again.

4. Choose Coloring » None. The tint coloring is removed from all histograms in the overlay plot.

ACTIVITY Modify the Line Style of a Single Histogram in the Overlay
1. Select the name of a single sample within the legend of the histogram overlay.

2. Right-click the sample name. 

3. Choose Line Style » Dashed Line. The line style of the selected sample histogram changes to a dashed line while all 
other lines remain solid. 

Lesson 4—The Layout Editor

1. Right-click on the plot 3. Right-click on the plot

2. Select Line Weight » Heavy

4. Select Coloring » None
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ACTIVITY Modify the Histogram Overlay Colors
If you don’t like the default colors of each individual histogram, this can also be modified. To do so:

1. Select the legend (corner handles should become visible), and click the square color box next to a sample name.

2. Select a different color from the pop-up color palette. The histogram color for that sample will change to your 
selected color.

Lesson 4—The Layout Editor

2. Right-click on highlighted 
sample name within legend

1. Highlight the first sample in 
the legend

Result: Line style of the selected 
sample histogram changes to dashed

3. Select Line Style » Dashed

2. Select a different color from 
the palette

1. Select the legend and click on a square 
color box next to  sample name

Result: Color of the histogram for that  
sample changes to the selected color
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ACTIVITY Change the Layering of Histograms in the Overlay
If you don’t like the default layering of the histogram overlay (which sample appears at the top versus bottom), this can 
also be modified.

1. Select the legend (the corner handles should become visible), then click and hold down the mouse button on the 
name of the sample you want to move.

2. Drag that sample name up or down through the legend. 

ACTIVITY Export Image
The Export Image function (located under the File tab in the Layout Editor ribbon) provides single-image export options 
for the currently displayed layout, saving the layout to an external file. Let’s save the current layout as a simple portable 
network graphics (PNG) image.

1. Select the File tab.

2. In the Document band, click Export Image.

3. Click the type of image file you wish to export (example: PNG). A save dialog box opens prompting you to select a 
save location.

4. In the save dialog box, give the image a name, or leave the default, which includes both the workspace and layout 
names (example: Mu FlowJo analysis-CD8+.png).

5. Select your preferred save location (example: Desktop).

6. Click Save. 

Lesson 4—The Layout Editor

2. Drag that sample through the 
legend to reorder

1. Highlight  the top sample in the legend

Result: Order of histogram is changed 
so that the selected sample is at the 
bottom instead of the top
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Try opening your saved PNG image. 

Because we are done creating layouts for now, close the Layout editor window by clicking the Close button at the top of 
the window.

End of Lesson 4—The Layout Editor

Lesson 4—The Layout Editor

2. Click Export Image 5. Save location

1. Select File tab
4. File name

3. Select image type (e.g. PNG)

6. Click Save
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Lesson 5—The Table Editor
The Table Editor is a platform for visualizing and exporting the statistics enumerated from gated populations. Like the 
Layout Editor, the Table Editor is provided in a separate window. 

Table Editor reports can be displayed for visual inspection and exported as text, CSV, Excel, and SQL database files. The 
process of saving a report from the Table Editor is similar to the batch reporting process in the Layout Editor. 

Components of the Table Editor
Ribbon—The Table Editor has its own ribbon with three tabs.

Table Editor—Add, duplicate, and delete tables, and set options for Iteration and output.

Edit—Add and edit columns, add keywords, and change Header/Footer options.

Visualize—Set heatmap, table formatting, and plot options.

ACTIVITY Add Populations to the Table Editor and Generate a Table to Display
Let’s bring some populations and statistics nodes into the Table Editor and generate a table to display.

1. In the Workspace window’s toolbar, click the latticework button to open the Table Editor,  and position the 
Workspace window and Table Editor side-by-side.

2. Select one or more populations and/or statistics nodes in the gating tree of a single sample in the workspace. 

3. Drag and drop the selected nodes into the Table Editor. For each selected node, a row appears within the Table 
Editor displaying the node gating hierarchy and type of statistic that is enumerated when the table is created.

4. In the Output band, click Create Table. The table is displayed in a new window below the Table Editor. Notice the 
orientation of the output table relative to the Table Editor list: Each row in the Table Editor becomes a column in 
the output table. Rows in the output table represent individual samples from the workspace group specified in the 
Iteration options.

Lesson 5—The Table Editor

2. Highlight gates and 
statistic nodes

3. Drag and drop to 
Table Editor

1. Open the Table Editor and position 
the windows side by side

4. Click Create Table
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ACTIVITY Rename a Row in the Table Editor
Sometimes a gating tree can get lengthy, 
and it is convenient to rename the 
population node in the Table Editor with a 
shortened name. 

1. Within a single row in the Table Editor, 
double-click the Name field.

2. Enter a unique name (example CD8 %).

3. Click Create Table. A new table is 
created using the name you specified.

ACTIVITY Add Heat-Mapping to the Table Output
To more readily visualize the range of 
enumerated statistics, apply visual formatting 
to the table output columns.

1. In the Table Editor, select all statistic rows.

2. In the Table Editor’s ribbon, select the 
Visualize tab.

3. Click Heat Map. A fire icon appears within 
the population column of each highlighted 
row in the Table Editor.

4. In the Table Editor’s ribbon, select the 
Table Editor tab.

5. Click Create Table.

A new output table displays. Each column in 
the table output is heat-mapped from blue to 
yellow, representing low to high values for the 
statistic in that column.

Lesson 5—The Table Editor

Result: Table output column 
header has a unique name

Result: Each statistic column in the 
output is independently heatmapped

1. Double-click on the name 
column cell

2. Enter a unique name
3. Click Create Table

1. Highlight statistics rows
2. Select visualize tab
3. Click Heat Map

4. Select Table Editor tab
5. Click Create Table
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ACTIVITY Save the Table as a Text File
Let’s export the data table, and save it to a file outside of the FlowJo application.

1. In the Output band, click the Display field. From the drop-down list, select To File. The file type field directly below 
is populated by Text, indicating that a text file will be saved when we create the table. Leave this default for now, but 
additional options are available, including CSV, Excel, HTML, and SQL files.

2. Click the Destination field, select a location to save the text file (example: Desktop), and click Save.

3. Click Create Table. 

The table is saved in the destination specified, and can be opened with any text editor or spreadsheet program. Note that 
you can also copy and paste the text from a displayed table to a spreadsheet to transfer information. 

Also, if you wish to retain the heat map formatting, try saving the table as an HTML file. The HTML file opens as an 
image in a web browser, including any visualization formatting.

Because we are done creating tables for now, close all the open Table Editor windows to get them out of the way.

End of Lesson 5—The Table Editor

Lesson 5—The Table Editor

1. Select To File from drop down
2. Click and select save location
3. Click Create Table
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Lesson 6—Saving the Analysis
The analysis structure created within a FlowJo workspace can be saved at any time by using the Save functions, which 
are located within the File tab of the Workspace window’s ribbon. 

File Formats
There are several different ways to save your analysis, depending on the need.

Workspace (WSP)—Saves the analysis and references to the data files. When you open the saved workspace, all the 
analysis and data files are present. The data is not duplicated, but instead is pulled in from wherever the files are located 
on a storage drive.

Archived Cytometry Standard (ACS)—Saves both the analysis and data files together in a zipped archive file. The data 
and analysis are included, and stay with the file if it is moved.

Workspace Template (WSPT)—Saves the analysis structure of your workspace without data files. The analysis structure 
of your workspace template can be applied to data files acquired in different experimental runs, as long as the measured 
parameters are identical. 

ACTIVITY Save the Analysis as a Workspace (.wsp) File 

1. In the Workspace window’s File tab, in the Document band, click Save As. 

2. Select Save as Workspace (WSP).

3. Enter a name for the workspace file.

4. Click Save. 

Lesson 6—Saving the Analysis

3. Enter a name
4. Click Save

1. Click Save As 
2. Select Save as Workspace (WSP)
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Reconnecting to Data
The workspace is saved in the specified directory location. When you reopen the workspace, all the analysis is retained, 
and the data files load from their saved location. 

Note that a regular workspace save does not make a duplicate copy of the data, but instead references the data files 
based on their directory location. If these files are moved, the workspace will open with red crosses to the left of the data 
files (in the Sample Quality badge), indicating that the raw data could not be found. 

To reconnect the workspace with the raw data, right-click a sample quality badge with the red X, and choose Search for 
FCS files. In the file browser, find and select the file folder containing the raw data. Note that it is enough to find the 
folder containing the raw data; it is not necessary to find the individual files.

Saving your analysis as an archive (ACS) file should prevent you from ever needing to reconnect the data to that 
workspace in future, because the file includes copies of the source data.

End of Lesson 6—Saving the Analysis

Lesson 6—Saving the Analysis

To reconnect data, right-click on sample quality 
badge with X and select Search for FCS files
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Conclusion
Thank you for taking the time to learn the fundamentals of FlowJo. Our goal is to produce software that is easy to use, 
easy to learn, and scientifically accurate. This tutorial has only scratched the surface of FlowJo’s powerful features and 
functions. Here are a few more things FlowJo can do, which were not covered in this tutorial:

Compensation—Corrects for overlap from the emission spectra of fluorochromes. As your experiments become more 
complex, the importance of accurate and automated compensation becomes more pronounced.

Derived Parameters—Supports the creation of new parameters through the algebraic combination of others, including 
a wide variety of functions and formula structures, analogous to computed columns in a spreadsheet.

Kinetic Analysis—Measures the change in signal of dyes, or ratios of dyes, over time. Generate statistics and 
subpopulations based on the subset of cells that have responded to stimulation.

Cell Cycle Analysis—Computes the percentage of cells in each phase of the cell cycle, based on a dye measuring the 
amount of DNA present in the cells (for example: 7AAD, PI, DAPI).

Proliferation Studies—Models the frequency of successive generations, and gate cells by the number of divisions 
undergone, as measured by intensity of CFSE, or other intracellular dye.

Dimensionality Reduction—Reduces multidimensional data into a 2D plot using t-Distributed Stochastic Neighbor 
Embedding (t-SNE).

Help links from any FlowJo window display the documentation page describing that topic, giving you context-
sensitive help.

Learn More:
Product information: https://www.flowjo.com/solutions/flowjo

Complete official documentation: http://docs.flowjo.com/d2

FlowJo University’s product training resources: https://www.flowjo.com/learn/flowjo-university

Technical Support: https://www.flowjo.com/support

Conclusion

https://www.flowjo.com/solutions/flowjo
http://docs.flowjo.com/d2
https://www.flowjo.com/learn/flowjo-university
https://www.flowjo.com/support



